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Productivity Apps for School and Work PA-1

Learn to use productivity apps!
Links to companion Sways, featuring 
videos with hands-on instructions, are 
located on www.cengagebrain.com.

© Rawpixel/Shutterstock.com

Productivity Apps for 
School and Work

Lochlan keeps track of 
his class notes, football 
plays, and internship 
meetings with OneNote.

Nori is creating a Sway 
site to highlight this year’s 
activities for the Student 
Government Association. Hunter is adding interactive 

videos and screen recordings 
to his PowerPoint resume.

Zoe is using the annotation 
features of Microsoft Edge 
to take and save web notes 
for her research paper.

Being computer literate no longer means mastery of only Word, Excel, 
PowerPoint, Outlook, and Access. To become technology power users, Hunter, 
Nori, Zoe, and Lochlan are exploring Microsoft OneNote, Sway, Mix, and Edge in 
O­ce 2016 and Windows 10.

In
 t
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M
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d
ul

e Introduction to OneNote 2016 ................. 2
Introduction to Sway ..................................6
Introduction to O�ce Mix ....................... 10
Introduction to Microsoft Edge .............. 14

OneNote 
Sway  
Offce Mix 
Edge

Corinne Hoisington
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Introduction to OneNote 2016
notebook | section tab | To Do tag | screen clipping | note | template | Microsoft  OneNote 
Mobile app | sync | drawing canvas | inked handwriting | Ink to Text   

As you glance around any classroom, you invariably see paper notebooks and notepads 
on each desk. Because deciphering and sharing handwritten notes can be a challenge, 
Microso� OneNote 2016 replaces physical notebooks, binders, and paper notes with a 
searchable, digital notebook. OneNote captures your ideas and schoolwork on any device 
so you can stay organized, share notes, and work with others on projects. Whether you 
are a student taking class notes as shown in Figure 1 or an employee taking notes in 
company meetings, OneNote is the one place to keep notes for all of your projects.

Bottom Line
•	 OneNote is a note-taking 

app for your academic and 
professional life.

•	 Use OneNote to get organized 
by gathering your ideas, 
sketches, webpages, photos, 
videos, and notes in one place.

Figure 1: OneNote 2016 notebook

Each notebook is divided into 
sections, also called section 
tabs, by subject or topic.

Personalize a page 
with a template, or 
stationery.

Pages can include 
pictures such as 
screen clippings, 
images from any part 
of a computer screen.

Attach files and 
enter equations 
so you have 
everything you 
need in one place.

Write or draw 
directly on the 
page using 
drawing tools.

Use To Do tags, icons that 
help you keep track of your 
assignments and other tasks.

Type on a page 
to add a note, a 
small window 
that contains 
text or other 
types of 
information.

Creating a OneNote Notebook
OneNote is divided into sections similar to those in a spiral-bound notebook. Each 
OneNote notebook contains sections, pages, and other notebooks. You can use One-
Note for school, business, and personal projects. Store information for each type of 
project in di�erent notebooks to keep your tasks separate, or use any other organiza-
tion that suits you. OneNote is �exible enough to adapt to the way you want to work. 

When you create a notebook, it contains a blank page with a plain white background 
by default, though you can use templates, or stationery, to apply designs in categories 
such as Academic, Business, Decorative, and Planners. Start typing or use the buttons 
on the Insert tab to insert notes, which are small resizable windows that can contain 
text, equations, tables, on-screen writing, images, audio and video recordings, to-do 
lists, �le attachments, and �le printouts. Add as many notes as you need to each page.

Syncing a Notebook to the Cloud
OneNote saves your notes every time you make a change in a notebook. To make sure 
you can access your notebooks with a laptop, tablet, or smartphone wherever you 
are, OneNote uses cloud-based storage, such as OneDrive or SharePoint. Microsoft  
OneNote Mobile app, a lightweight version of OneNote 2016 shown in Figure 2, is 
available for free in the Windows Store, Google Play for Android devices, and the 
AppStore for iOS devices.

If you have a Microso� account, OneNote saves your notes on OneDrive auto-
matically for all your mobile devices and computers, which is called syncing. For 
example, you can use OneNote to take notes on your laptop during class, and then 

Learn to use OneNote!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.
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open OneNote on your phone to study later. To use a notebook stored on your com-
puter with your OneNote Mobile app, move the notebook to OneDrive. You can 
quickly share notebook content with other people using OneDrive.

Taking Notes
Use OneNote pages to organize your notes by class and topic or lecture. Beyond sim-
ple typed notes, OneNote stores drawings, converts handwriting to searchable text and 
mathematical sketches to equations, and records audio and video.

OneNote includes drawing tools that let you sketch freehand drawings such as bio-
logical cell diagrams and �nancial supply-and-demand charts. As shown in Figure 3, the 
Draw tab on the ribbon provides these drawing tools along with shapes so you can insert 
diagrams and other illustrations to represent your ideas. When you draw on a page, One-
Note creates a drawing canvas, which is a container for shapes and lines. 

OneNote is ideal for taking notes 
during meetings, whether you are 
recording minutes, documenting 
a discussion, sketching product 
diagrams, or listing follow-up 
items. Use a meeting template 
to add pages with content 
appropriate for meetings. 

On the Job Now

Figure 2: Microsoft OneNote Mobile app

Notes synced to 
OneDrive and 
displayed on a 
smartphone 

Draw tab

Pens and 
highlighters 
are in the 
Tools group.

Insert text 
using the Type 
button in the 
Tools group.

Insert rectangles 
and lines from the 
Shapes group.

Lines and shapes are 
in the Shapes group.

Make drawings 
using pens in 
the Tools group.

Figure 3: Tools on the Draw tab

Converting Handwriting to Text
When you use a pen tool to write on a notebook page, the text you enter is called 
inked handwriting. OneNote can convert inked handwriting to typed text when 
you use the Ink to Text button in the Convert group on the Draw tab, as shown in  
Figure 4. A�er OneNote converts the handwriting to text, you can use the Search box 
to �nd terms in the converted text or any other note in your notebooks.
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Figure 4: Converting handwriting to text

Ink to Text button

Handwriting 
converted to 
searchable text

Writing inserted 
with a fingertip

Recording a Lecture
If your computer or mobile device has a microphone or camera, OneNote can record the 
audio or video from a lecture or business meeting as shown in Figure 5. When you record 
a lecture (with your instructor’s permission), you can follow along, take regular notes at 
your own pace, and review the video recording later. You can control the start, pause, and 
stop motions of the recording when you play back the recording of your notes.

Use OneNote as a place to brain-
storm ongoing work projects. If 
a notebook contains sensitive 
material, you can password-pro-
tect some or all of the notebook 
so that only certain people can 
open it. 

On the Job Now

Figure 5: Video inserted in a notebook

Math Lecture 
video file

Video recording

Record Video 
button

Audio & Video 
Recording tab
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Try This Now
1: Taking Notes for a Week
As a student, you can get organized by using OneNote to take detailed notes in your 
classes. Perform the following tasks:

a. Create a new OneNote notebook on your Microso� OneDrive account (the 
default location for new notebooks). Name the notebook with your �rst name 
followed by “Notes,” as in Caleb Notes.

b. Create four section tabs, each with a di�erent class name.
c. Take detailed notes in those classes for one week. Be sure to include notes, drawings, and other types of content.
d. Sync your notes with your OneDrive. Submit your assignment in the format speci�ed by your instructor.

2: Using OneNote to Organize a Research Paper
You have a research paper due on the topic of three habits of successful students. Use OneNote to organize your research. 
Perform the following tasks:

a. Create a new OneNote notebook on your Microso� OneDrive account. Name the notebook Success Research.
b. Create three section tabs with the following names:

•	 Take Detailed Notes
•	 Be Respectful in Class
•	 Come to Class Prepared

c. On the web, research the topics and �nd three sources for each section. Copy a sentence from each source and paste 
the sentence into the appropriate section. When you paste the sentence, OneNote inserts it in a note with a link to the 
source.

d. Sync your notes with your OneDrive. Submit your assignment in the format speci�ed by your instructor.

3: Planning Your Career
Note: �is activity requires a webcam or built-in video camera on any type of device.

Consider an occupation that interests you. Using OneNote, examine the responsibilities, education requirements, potential 
salary, and employment outlook of a speci�c career. Perform the following tasks:

a. Create a new OneNote notebook on your Microso� OneDrive account. Name the notebook with your �rst name 
followed by a career title, such as Kara - App Developer.

b. Create four section tabs with the names Responsibilities, Education Requirements, Median Salary, and Employment 
Outlook.

c. Research the responsibilities of your career path. Using OneNote, record a short video (approximately 30 seconds) of 
yourself explaining the responsibilities of your career path. Place the video in the Responsibilities section.

d. On the web, research the educational requirements for your career path and �nd two appropriate sources. Copy a para-
graph from each source and paste them into the appropriate section. When you paste a paragraph, OneNote inserts it 
in a note with a link to the source.

e. Research the median salary for a single year for this career. Create a mathematical equation in the Median 
Salary section that multiplies the amount of the median salary times 20 years to calculate how much you will 
possibly earn.

f. For the Employment Outlook section, research the outlook for your career path. Take at least four notes about what you 
�nd when researching the topic.

g. Sync your notes with your OneDrive. Submit your assignment in the format speci�ed by your instructor.

Learn to use OneNote!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.

Copyright 2017 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.  WCN 02-200-203



PA-6 Productivity Apps for School and Work

Introduction to Sway
Sway site | responsive design | Storyline | card | Creative Commons license | animation 
emphasis e�ects | Docs.com 

Expressing your ideas in a presentation typically means creating PowerPoint slides 
or a Word document. Microsoft Sway gives you another way to engage an audience. 
Sway is a free Microsoft tool available at Sway.com or as an app in Office 365. 
Using Sway, you can combine text, images, videos, and social media in a website 
called a Sway site that you can share and display on any device. To get started, 
you create a digital story on a web-based canvas without borders, slides, cells, or 
page breaks. A Sway site organizes the text, images, and video into a responsive
design, which means your content adapts perfectly to any screen size as shown in 
Figure 6. You store a Sway site in the cloud on OneDrive using a free Microsoft 
account.

Bottom Line
•	 Drag photos, videos, and 

files from your computer and 
content from Facebook and 
Twitter directly to your Sway 
presentation.

•	 Run Sway in a web browser or 
as an app on your smartphone, 
and save presentations as 
webpages.

Figure 6: Sway site with responsive design

You can display a 
Sway presentation 
in a web browser.

Sway uses 
responsive 
design to make 
sure pages fit 
perfectly on 
any device.
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Learn to use Sway!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.

Creating a Sway Presentation
You can use Sway to build a digital �yer, a club newsletter, a vacation blog, an informa-
tional site, a digital art portfolio, or a new product rollout. A�er you select your topic 
and sign into Sway with your Microso� account, a Storyline opens, providing tools 
and a work area for composing your digital story. See Figure 7. Each story can include 
text, images, and videos. You create a Sway by adding text and media content into a 
Storyline section, or card. To add pictures, videos, or documents, select a card in the 
le� pane and then select the Insert Content button. �e �rst card in a Sway presenta-
tion contains a title and background image. 

Copyright 2017 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.  WCN 02-200-203



Productivity Apps for School and Work� PA-7

Figure 7: Creating a Sway site

Design and create 
Sway presentations.

To add content, select a 
card, which is designed 
to hold a particular type 
of information.

Arrange content in a Storyline, 
which contains all the text, 
pictures, videos, and other 
media in a Sway presentation.

Share and play 
published Sway sites.

After selecting a card, 
click the Insert Content 
button to add the content 
to the Sway presentation.

Adding Content to Build a Story
As you work, Sway searches the Internet to help you �nd relevant images, videos, 
tweets, and other content from online sources such as Bing, YouTube, Twitter, and 
Facebook. You can drag content from the search results right into the Storyline. In 
addition, you can upload your own images and videos directly in the presentation. 
For example, if you are creating a Sway presentation about the market for commer-
cial drones, Sway suggests content to incorporate into the presentation by displaying 
it in the le� pane as search results. �e search results include drone images tagged 
with a Creative  Commons license at online sources as shown in Figure 8. A Creative 
Commons license is a public copyright license that allows the free distribution of an 
otherwise copyrighted work. In addition, you can specify the source of the media. For 
example, you can add your own Facebook or OneNote pictures and videos in Sway 
without leaving the app.

If you have a Microsoft Word 
document containing an outline 
of your business content, drag the 
outline into Sway to create a card 
for each topic.

On the Job Now

Figure 8: Images in Sway search results

Storyline title

Drag an image to the 
picture placeholder box

Suggested images in 
the search results

Information about Creative 
Commons licensesSelect the source 

of media objects

Copyright 2017 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.  WCN 02-200-203




